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1. CityGRID® Shaper Basics 

Shaper is a stand-alone module of the CityGRID® Software Suite. With the corresponding data sets, 

building models can be created semi-automatically from LiDAR or matched pointclouds. 

 

1.1. System requirements 

A standard computer with 32GB RAM and a 3D-capable graphics card is sufficient to operate the 

CityGRID® Shaper. Since shaper projects can become very large, a correspondingly large data 

storage is required (min. 1 TB). 

The installation of a current FME version is required for the creation of shaper projects. 

1.2. Geometry concept 

Planes are automatically extracted from the pointclouds, whose area of validity is approximately 

limited with a polygon (alphashape). The intersection of two alphashapes generates an 

intersection line at a building edge, which is used for the building preview (Smart Preview).  

To generate a valid intersection line, two conditions must be met: The two alphashapes involved 

in the intersection line must be clearly to the left and right of the intersection line respectively, 

and the two alphashapes must be sufficiently close to each other. The user has no influence on 

this, the quality of the pointcloud is decisive for this. 

 If only one of the two requirements is met, an invalid intersection line is created, which is not 

displayed by default. Under certain circumstances, however, it can be helpful to display these 

invalid lines. More on this in chapter 2.3.3.3. 

A section line can have different states which can be influenced by the user. The intersection of a 

plane (not its alphashapes) with the base plane creates the baselines, whose state depends on the 

state of the intersection. Through user interaction, a building preview can be created with the 

intersection lines and the baselines. When this preview is accepted, possibly edited and finally 

saved, the building is saved to a CityGRID®.xml.  
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There are four geometry classes in Shaper, which can be in different states:  

a) Point geometry: 

• Pointcloud points:  

Status User interaction 

Assigned to a plane Show/Hide 

Not assigned to a plane Show/Hide 

Coloured depending on the assigned plane Show/Hide 

 

• Vertices:  

Are always part of a line, an alphashape or an outline and therefore have the state of their 

parent geometry. They can only be changed in the accepted state of the parent geometry. 

 

Parent geometry User interaction 

Line Move end vertices or centre point in position 

Alphashape Move, add or delete vertices 

Outline Move, add or delete vertices 

b) Line geometry: Shaper uses intersection lines and baselines. 

• Intersection lines  

Status Description User interaction 

Invalid (not 

displayed) 

Intersection lines that have not 

achieved candidate status 

because not all requirements have 

been met. 

Are hidden by default but 

can be shown in certain 

situations. 

 

Candidate (Red) Status of a valid intersection line 

before user interaction. 

 

 

Used (Blue) Intersection line used for Smart 

Preview 

Mouse Hover over a line in 

candidate status changes 

status to Used; building 

preview is created. 

Accepted (Green) An intersection line accepted by 

user interaction, the preview of 

this line was accepted, however, 

in interaction with other 

candidates, the preview is still 

dynamically adjustable. 

With an LMC on the Used 

intersection line, the status 

changes to Accepted. 
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Completed (Black) An intersection line completed by 

user interaction. The preview of 

this intersection line is fixed and 

can no longer be changed by other 

intersection line candidates. 

Command Accept Building 

or Finish Building Part. The 

intersection lines of these 

buildings are excluded from 

further preview.  

Deactivated (Grey) Deactivated intersection lines are 

lines in candidate status that are 

deliberately excluded from the 

Smart Preview by user interaction. 

They are no longer used for 

dynamic face generation.  

 

Ctrl + LMC to deactivate or 

reactivate intersection 

lines.  

Set aside (Magenta) Lines in candidate status are put 

aside if one of the involved layers 

has too few points through user 

interaction to form a valid plane 

and thus an intersection line with 

another plane cannot be valid 

either. 

Only lines in candidate 

status are set aside if the 

user filters the pointcloud 

so strongly with the data 

filter that some layers have 

no or too few points. The 

affected layers are hidden, 

the associated candidate 

lines are set aside. 

 

• Base lines:  

The status of baselines depends exclusively on the status of the originating intersection 

lines. 

Status User interaction 

Used (Blue) Baselines are used when the associated 

intersection line is used. 

Accepted (Green) Baselines are accepted if the associated 

intersection line is accepted. 

Finished/Invalid baselines Are not displayed 

 

c) Polygon geometry: planes can have two types of polygons. 

• Alphashape: is the automatically found boundary of a plane that is only approximated 

and often too small. If an intersection line between two planes is accepted, these 

planes get an outline in addition to the alpha shape. An outline can also be drawn in a 

flat roof situation where there are no plane intersections.  

Editing an alpha shape (adding, deleting, or moving a vertex) has a direct influence on 

the resulting intersection lines and thus an indirect influence on the face generation. 
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• Outline: is the user-edited or -created boundary that can delimit the plane more 

precisely. The extent of the outline determines the face generation. The vertices of an 

outline cannot be edited if they are on the border of another plane and editing them 

would change the intersection (ridge) between the planes.  

Editing outlines (adding, moving, or deleting vertices) has a direct influence on face 

generation.  

 

 

Note:  Editing an outline should not be followed by any more work with the alphashapes 

concerned or the associated intersection lines, as a user interaction on the outline takes 

precedence over that of the alphashape. 

 

 

d) Faces: No status, are derived from accepted lines or outlines 

Editable Geometries: 

Not all of the geometry classes mentioned can be edited.  

a) Vertices: 

 can be moved, added or deleted depending on their parent geometry. 

b) Lines:  

- Intersection Lines: Can be modified in length. 

- Baselines: Can be moved in the plane. 

c) Alphashapes:  

Can be changed in their extension by changing their vertices and thus also change the 

intersection lines. 

d) Outlines: 

Can be changed in their extension by changing their vertices and thus change the face 

generation. Not all vertices of an outline can always be changed. The outlines of two planes 

that are adjacent to each other cannot be changed at the points of contact, as this would result 

in a change of the intersection line. 

 

1.3. Data basis 

To create CityGRID® Shaper projects, a Lidar pointcloud dataset or a matched pointcloud dataset 

in .las or .laz format is required. The best results can be achieved with a classified LiDAR pointcloud, 

but if this is not available, pointclouds reduced/filtered to the buildings can also be used. 

 

Note:  Denser is not always better. Shaper needs a minimum number of about 10 points 
per m2 if these points are sufficiently well distributed. With a very dense matched 

pointcloud, plane extraction is sometimes much more difficult than with a highly thinned 

LiDAR pointcloud due to stray points. 
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Excessive points from terrain, vegetation or other "non-buildings" sometimes affect performance 

and should be removed before a project is created. In addition, these points can interfere with 

automatic plane detection and create superfluous or even incorrect planes.  

To enable productive work, a pointcloud must have at least intensity values, ideally RGB values. If 

neither is available, the pointcloud can be coloured via a corresponding orthophoto in .tiff or .jpg 

format during project creation.  

Since an orienting and navigating in the pointcloud alone sometimes causes difficulties, the 

additional usage of aerial images is recommended. The aerial images (oblique and/or Nadir) must 

have orientation values that are transferred in advance into a CityGRID® XML format using an FME 

workspace and are processed during project creation. 

1.4. Start Modul CityGRID® Shaper 

The CityGRID® Shaper is started via the Windows start menu entry.  

1.5. Setting the language 

Depending on which language is active, the menu item Spracheinstellungen or Localisation 
appears in the Help menu. Select the desired language of the user interface and restart the 
application. 

1.6. Logging 

In the event of an unforeseen programme action or a programme crash, it may be necessary to 
send the log file to UVM Systems GmbH. Extended logging can be activated via the menu item 
Feedback. Via the menu item Send feedback, the necessary log files are packed together and 
attached to an email in an installed email client to be sent by the user to the support. Extended 
logging takes more time and should therefore only be used after consultation with UVM Systems 
GmbH. 
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2. The User Interface 

After starting Shaper, an initially empty user interface appears. To be able to see the full scope of 

Shaper, either an existing project must be loaded (via menu File > Open) or a new shaper project 

must be created (menu File > New, see Fehler! Verweisquelle konnte nicht gefunden werden. ). 

 

 

 

 

 

   

 

 

 

 

 

 

 

 

 

The main window contains the central control mechanisms for the following tasks: 

• Setting the data source and potentially recalculating pre-calculated data  

• Parameters that change depending on the mode set 

• Building creation 

  

2D Window 

Aerial photos with line 
representation of the active 
building as a modelling aid 

Menu CGShaper  

Here you will find general 
functions 

Main window 

Main tools depending on 
the set workspace and 
editing mode 

Toolbar 

Switching the workspace, switching 
the editing modes, controlling the 
visibilities 

Logwindow 

Process monitoring 

Status bar 

If necessary, instructions to the user 
are given here 

3D-Window 

Display of the pointcloud and the 
derived geometries (lines, alpha 
shapes and surfaces). 
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2.1. Menu 

2.1.1. File 

2.1.1.1. New 

Expects the specification of a project folder in which all data created subsequently will be 

saved. After specifying the project folder, the "Create Shaper Data" dialogue opens, which 

guides you through the creation of the project. (Chapter 3) 

2.1.1.2. Open 

Opens an already created shaper project. 

2.1.1.3. Recently opened projects. 

Shows a list of recently opened projects. 

2.1.1.4. Export 

Exports all completed buildings of a project to a CityGRID® XML file whose location must 

be specified. Any external data (such as building floor plans and DTMs) are also saved in 

this file. 

2.1.1.5. Exit 

Exits Shaper. 

 

2.1.2. Edit 

2.1.2.1. Optional Data 

Opens the dialogue for updating or adding external data (already when creating the 

shaper project, external data can be added to the project, building ground plans, terrain 

and/or existing city models). 
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2.1.2.2. Search 

Enables the search for a shaper building, a building 

from an integrated existing city model or for an 

integrated building ground plan. A string is expected 

as the search term. 

 

2.1.2.3. Create Building Attributes 

If this option is set, an attribute dialogue is opened when closing a building, which allows 

several predefined attributes. These are saved as CityGRID® unit attributes in the adopted 

building. This option is greyed out, only available if only optional attributes have been 

defined. If a mandatory attribute has been defined, the dialogue cannot be suppressed.  

2.1.2.4. Edit Attributedefinition  

In this dialogue, either attribute definitions that were prepared during project creation 

can be edited, or new ones can be created. 

 

Note: If buildings have already been saved with an existing attribute definition, a new 

definition does not change the existing attributes. Even if buildings have been saved 
without attributes, creating an attribute definition in the editing process will not add 

attributes to already saved buildings. The attributes created or changed only apply to 

those buildings that are saved AFTER the definition. 

 

2.1.2.5. Edit Hotkey Settings 

A dialogue opens in which the default settings for hotkeys can be changed and reassigned. 

Hotkeys are already set for a number of actions of the CityGRID® Shaper. However, these 

can be changed via the menu Edit > Edit hotkey settings. Here the existing 

hotkeys can be displayed sorted by groups. When selecting a command in the hotkey list, 

the existing hotkey is displayed. Press Assign and press a new hotkey combination (Alt 

cannot be used because Alt is already reserved for menu entries). If a key combination is 
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assigned more than once, a warning appears in the lower window, but it is still 

permissible. A key combination can be removed via the Remove button. Reset resets 

to the default settings. Save saves the defined hotkeys. 

 
 

 

 

2.1.2.6. Options  

Not yet implemented. 

2.1.2.7. Colour options 

Not yet implemented.  

2.1.3. Windows 

2.1.3.1. Scout 3D 

The 3D window can be switched on/off. 

2.1.3.2. Texture 2D 

The 2D window can be switched on/off. 

2.1.3.3. Logging 

The Logging window can be switched on/off. 

2.1.3.4. Main Toolbox 

The Main toolbox can be switched on/off. 
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2.1.4. Feedback 

2.1.4.1. Extended Logging 

When troubleshooting, this option can be activated. 

2.1.4.2. Send Feedback  

The error description (protocol and additional data) is zipped and added as an attachment 

in the installed email programme in an empty email. 

 

2.1.5. Help 

2.1.5.1. Manual 

Opens the Manual of CityGRID® Shaper. 

2.1.5.2. About CityGRID® Shaper 

Shows version information for CityGRID® Shaper. 

2.1.5.3. Localisation 

Allows you to change the language settings, options are German, English, Turkish. 

2.2. The Toolbar 

 

 

 

2.2.1. General functionalities 

2.2.1.1. Switching Workspace 

(Default Hotkey E) 

This button can be used to switch from selection mode to the general editing mode and 

back. Beforehand, an area must be selected with the size-adjustable selection cube. 

 

2.2.1.2. Undo 

(Default Hotkey Ctrl +Z)   

Undoes the last editing action. Right-clicking opens the context menu and allows you to 

undo several editing actions. 

 

2.2.1.3. Redo 

(Default Hotkey Ctrl +Y) 
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Restores the last editing action. Right-clicking opens the context menu and allows you to 

restore several editing actions. 

 

2.2.1.4. Snapping  

(Default Hotkey S)  

Snapping is activated with a left mouse click (or with a hotkey). However, snapping only 

works if the options are set in the context menu. 

A right mouse click opens the context menu of this button, in which various snapping 

options can be set. 

▪ Geometry class: 

Which geometry class do I want to snap to? (Multiple selection possible):  

•  Pointcloud 

•  Faces   

•  Lines. 

▪ Geometry elements: 

Which elements within the selected geometry class(es) do I want to snap to? 

(Multiple selection possible) 

• Vertex (in geometry classes pointclouds, faces or lines), 

• Edges (in geometry classes faces or lines),  

• Faces (in in geometry classes faces),  

• Centrepoint (in geometry classes lines or faces).  

▪ Constraints: 

Here the geometries can be constrained (multiple selection possible). 

• Perpendicular: Allows Snap only to geometries at perpendicular 

angles. 

• Parallel: Allows snap only to geometries parallel from the initial 

geometry. 

• Vector: Allows snap only along the direction vector of a line or of 

the incoming or outgoing segment of a polygon. 

 

2.2.1.5. Bindings 

(Default Hotkey B)  

Bindings are activated by default. The baselines of a roof are connected to each other. If 

it becomes necessary to move baselines independently in the plane (e.g. in the case of 

cripple hipped roofs), it is important to remove the bindings beforehand. 

 

 

Note: Do not forget to reactivate the bindings when the action for which the unbinding 

was necessary has been completed. 
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2.2.2. Editing functionalities 

Changing the editing mode also changes the available functions in the main toolbox. 

Detailed description of the editing functions under chapter Fehler! Verweisquelle konnte n

icht gefunden werden.. 

2.2.2.1. Smart Preview  

(Default Hotkey F1)  

The Smart Preview is the start mode for creating and editing a building. Buildings can be 

created here by placing the user's mouse over a red intersection line candidate, waiting 

until it turns blue, and accepting the preview with a click. With the general editing 

functions (chapter 2.3.2) building parts can be closed (the preview is fixed) and 

reactivated. Entire buildings can be saved, edited in the Modeler, or deleted. 

 

2.2.2.2. Baseplane editing mode  

(Default Hotkey F2) 

This mode is only active if the checkbox Set base plane automatically is 

deactivated in Smart Preview mode. The base plane is used to delimit the building planes, 

the baselines are the result of the intersections between building and base planes. If the 

automatically set base plane leads to undesired results for the base lines, it can be set 

manually in the base plane edit mode. 

A left mouse click sets the base plane through the lowest point of the selected alpha 

shape. 

If Ctrl is additionally hold down, a point of the pointcloud can be selected through which 

the base plane is set. 

2.2.2.3. Line Editing Mode  

(Default Hotkey F3) 

In line editing mode, intersection lines and baselines can be edited individually. A line 

must always be selected first. A selected line is highlighted in yellow, depending on its 

type (intersection line or baseline) different editing options are available. 

 

2.2.2.4. Alphashape Editing Mode 

(Default Hotkey F4) 

For more complex buildings, it may sometimes be necessary to edit the alphashapes to 

obtain more accurate intersection line results.  

To edit an alphashape it is necessary to select an alphashape, which is then highlighted in 

both the 3D window and the 2D window. In both windows the vertices of the alphashape 

can be edited (moved, deleted, added). In the 3D window you can deactivate an 

Alphashape by clicking on a segment, it changes colour and is displayed in light grey. The 

intersection lines in which the alphashape is involved disappear in this state. The 

alphashape can be reactivated with another click.  
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Note: Only one alphashape can be selected and edited at a time. To end the selection 

and choose another alphashape, press Esc. 

 

 

2.2.2.5. Outline Editing Mode 

(Default Hotkey F5) 

The outlines of planes can be edited in some cases, in other cases (flat roofs) they must 

be created. 

When intersection lines are accepted in the Smart Preview, outlines are subsequently 

created automatically - in addition to the alphashapes involved. Sometimes it may be 

necessary to edit these outlines, for example if the intersection line is shorter than the 

eaves to be created. Since the baselines automatically adjust to the length of the 

intersection line, they cannot be extended independently. 

 

 

Note: Before editing an outline, all actions that affect the lines (extend, move) should 

be finished. An edited outline is weighted higher than the edited lines, therefore editing 

the lines afterwards can lead to undesired results. 

 

 

2.2.2.6. Detail Editing Mode (Default Hotkey F6) 

Not yet implemented. 

2.2.3. Visibility functionalities 

2.2.3.1. Show assigned points  

(Default Hotkey Ctrl +1) 

Points assigned to a plane can be shown and hidden. 

 

2.2.3.2. Show assigned points (colour)  

(Default Hotkey Shift +1) 

Points that have been assigned to a plane and coloured depending on the plane can be 

shown and hidden. 

 

2.2.3.3. Show base plane 

(Default Hotkey 2) 

This button becomes active if the option Set base plane automatically in 

Smart Preview mode is not set. This allows you to control the visibility of the base plane. 
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2.2.3.4. Show intersection lines  

(Default Hotkey 3) 

Intersection lines can be shown or hidden. 

 

2.2.3.5. Show Alphashapes  

(Default Hotkey 4) 

Alphashapes can be shown or hidden. 

 

2.2.3.6. Show Faces  

(Default Hotkey 5) 

The faces of the Smart Preview can be shown or hidden. 

 

2.2.3.7. Show accepted Buildings  

(Default Hotkey 6) 

Accepted buildings can be shown or hidden. 

 

2.2.3.8. Show unused points   

(Default Hotkey 1) 

The points that are not assigned to an alphashape can be shown or hidden. 

 

2.2.3.9. Show unused data (alphashapes and lines) 

(Default Hotkey 1) 

Disabled alphashapes or lines in the selection area can be shown or hidden. 

 

2.2.3.10. Show Existing Buildings 

(Default Hotkey 7) 

An existing city model in the selection area can be shown or hidden. 

 

2.2.3.11. Show DTM   

(Default Hotkey 8) 

A DTM can be shown or hidden in the selection area. 

 

2.2.3.12. Show footprints 

(Default Hotkey 9) 

The building footprints of the selection area can be shown or hidden. 
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2.3. The main toolbox 

 The main toolbox changes its appearance depending on the selected mode. 

Selection Mode                     Editing Mode 

                                                        

2.3.1. Selection mode 

Immediately after creating the Shaper project, or each time the Shaper is restarted, the project is in 
selection mode. This means that all buttons except for the "Change workspace" button in the toolbar 
are deactivated, the entire precalculated pointcloud is displayed in the 3D window, and no images are 
displayed in the 2D window. In the 3D window the yellow highlighted selection cube can be dragged 
over the pointcloud with the left mouse button to define a new selection area. The selectable 
pointcloud is highlighted green. 

In the main toolbox, the selection parameters can be used to change this selection area. 

• Selection Size: 

controls the size of the selection 

range. 

For pre-calculated data the maximum 

is 150 m, for real-time calculation the 

maximum is 500 m. 

• Point Size:  

controls the display of the point size of the pointcloud. 

  

Selection mode 

Selection  
Parameters 

Datasource 

Paramaters 
for Realtime 
Calculation 

Infobox of 
Selection Mode 

Editing Mode 

SmartPreview 
Editing Mode 

Selection 
parameters 

Building creation 

Constant editing 
parameters 

Mode dependent 
editing parameters 

Infobox of set editing 
mode 
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Data source:  

The Data source section determines whether the 

pre-calculated data is to be used or, if the project 

calculated with the default settings does not 

meet the individual requirements.  

If the project calculated with the default settings 

does not meet the individual requirements, 

partial areas or the entire project can be 

recalculated with the real-time calculation and by 

changing the respective parameters. Pre-

calculated datasets can be deleted with the 

button 

Parameter for real time calculation: 

• General 

❖ Search radius 

Controls the size of the search radius 

within which points are selected for 

segmentation. It also controls the 

accuracy of the alphashapes. If 

alphashapes frequently "break up" (i.e. 

several polygons within an alphashape 

where there should actually only be one), 

it is recommended to reduce the radius. 

 

In general, sufficient quality of the input data 

must be ensured. Nevertheless, there are possibilities to address different problems in the specific 

data set. 

• Plane Fitting 

❖ Method for plane estimation (selection): depending on the choice of plane estimation, the 

number of neighbours must be increased.  

❖ Simple plane fit  

Recommended for clean, clear (LiDAR) pointclouds. It is the fastest, simplest plane 

adjustment without discarding outliers (stray points), 8 neighbours are sufficient (default 

value). 

❖ robust plane fit 

Recommended for well-matched pointclouds or rougher LiDAR pointclouds. It is an 

iterative adjustment in which the points with the largest deviation are successively 

removed from the point selection. Due to the iterative nature of the adjustment, robust 

plane adjustment is somewhat more time-consuming than simple plane adjustment. The 

number of neighbours must be increased for this method. This method only works if there 

are not too many gross errors. In addition, there must be correct points in the area of the 

gross errors, otherwise the errors will not be recognised as such. In general, there should 

not be more than 20% of wrong points in the pointcloud to use this method. 
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❖ Minimum Covariance Determinant 

Recommended for imprecisely matched pointclouds with many outliers. The robust plane 

fit with minimum covariance determinant generally allows for more errors (not 

unlimited!) than the robust level matching. The number of neighbours must be further 

increased for this. 

 

Note: too many neighbours can "smear" the surface normals at the edges, which can 

again lead to difficulties in alphashape creation. With difficult data, it is recommended 
to work with a sample to make it easier to work out the ideal values for the entire data 

set. 

 

 

❖ Neighbours (Slider): Number of neighbour (points) to be used for the plane estimation. 

Depending on the choice of plane estimation, the number of neighbours must be increased. 

 

• Segmentation: 

❖ Min. segment points 

❖ Controls the minimum number of points needed to form an alphashape. The lower the number 

of points, the more alphashapes are formed. By default, at least 100 points are necessary for 

an alphashape. If no alphashapes are found for smaller planes, but they would be necessary 

for sensible modelling, it is helpful to set a lower value here. 

❖ Max. distance (Slider) 

Defines the maximum distance a point may lie from a plane in order to be assigned to this 

plane. An increase in this value is recommended especially for unstable data, as it increases 

the tolerance for the formation of planes. If, for example, a plane is found from points lying 

close together where there should actually be two planes, it is helpful to reduce the maximum 

distance so that the distance between the points is higher than the value of Max. Distance. 

                   

Max. Distance = 0.20m             Max. Distance =0.10m  

❖ Max. Sigma (Slider) 

Sets the maximum normal accuracy used. If points have a maximum Sigma, that is higher than 

the setting of this value, they are not used for segmentation. Recommended is a value similar 

to or lower than the set Max. Distance. Assuming the Max. Distance is set very high (tolerant) 

and Max. Sigma is quite low (strict), points that would still be used for segmentation due to 

their distance will still be removed due to the strict Max. Sigma value. Thus, too few planes 

may be found again. 

❖ Max. Normal deviation. 
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Defines how much the normal of a point may deviate in order to be used as a seed point. A 

seed point is the point from which the plane found is extended further and further by adding 

points that fit into the plane.   

The default value of 0.02 m is sufficient for most data situations, but if the quality of the 

pointcloud is rather insufficient and no planes are found, it can help to increase this value to 

also allow "worse" points. 

 

Save pre-calculation:  

Allows you to enter a name for the set parameter set with which the data will be recalculated. This 

name is added under Pre-calculated data after the calculation and can be selected before switching 

to edit mode. 

 

Start calculation. 

Calculates the alphashapes with the new settings for the entire data set, which may take some time.  

 

Note: If parameters are changed without recalculating, these new settings only affect the 

data of the selection area when switching to edit mode. 

 

 

2.3.2. General editing functionalities  

When switching from selection mode to editing mode, the settings in the main toolbox change. 

Some of them remain the same across all special editing modes (general editing functions), some 

change depending on the mode set.  

2.3.2.1. Selection parameters 

❖ Selection size: In edit mode, the selection size controls the range of points displayed. 

❖ Point size: Controls the point size of the pointcloud. 

2.3.2.2. Building creation: 

❖ Datafilter: Filters the visible alphashapes according to size. The left slider filters small 

alphashapes (with a low number of points), the right slider filters large alphashapes 

(with a high number of points). 

2.3.2.3. General Editing Functionalities:  

Finish Buildingpart (Button) takes over the generated ❖  

faces and lines of a building part and fixes the faces of the Smart 

Preview. 

 

❖  Select Active Buildingpart (Button) Allows the re-

editing of a building section that has already been completed. 
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❖  Accept Building (Button Accepts a building (which can 

consist of several building parts) and writes it to a CityGRID®  xml 

file. An accepted building can no longer be edited in the Shaper.   

If Attributes (see 

Menu > Create 

Building Attributes, 

Chapter 2.1.2.3 

Fehler! 

Verweisquelle 

konnte nicht 

gefunden werden.) is 

activated, an 

attribute dialogue is 

opened in which the 

corresponding values 

for the building can 

be entered. By 

pressing the Confirm 

button, the building is written into the XML file. This process cannot be undone.  

 

 

❖  Delete Building (Button) Deletes an accepted building. 

This process cannot be undone. 

 

❖  With  Edit Building in Modeler an accepted building 

can be loaded and edited in the Modeler, provided the 

Modeler has already been started and placed in waiting position. See Modeler 

Manual, Chapter 3.6.3. Editing buildings in Shaper is blocked until the editing is saved 

and finished in Modeler, Modeler is brought back to the waiting position and the open 

dialogue in the shaper is closed with Stop editing. The edited building(s) is/are 

subsequently updated in Shaper. 

 

Note: It is no longer possible to edit these buildings again in Shaper. 

 

 

2.3.2.4. Parameter:  

▪ Selection tolerance 

❖ Selection tolerance (m) 

The selection tolerance affects all operations that work with pointcloud points in the 

3D area. It is the radius around the mouse position in which, for example, intersection 

lines are accepted in the Smart Preview (as a result of planes in pointclouds). The 
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larger this value is, the larger is the area around the mouse position in which the 

points necessary for creating alphashapes are selected. 

❖ Pixel tolerance (px) 

The pixel tolerance works accordingly to the selection tolerance on line- and 

alphashape segments as well as vertices. Only those segments/vertices can be 

selected that are within this radius around the mouse position. 

▪ Intersection lines processing 

❖ Buffer width (m) 

Specifies the maximum width of the strip around the intersection line between two 

alphashapes to be offered as a valid intersection line candidate. The value influences 

the number of intersection line candidates found, the higher the value, the more valid 

intersection line candidates are found. 

❖ Overlaps (%) 

Intersection lines of overlapping alphashapes are displayed depending on the set 

degree of overlap. Such overlaps of two alphashapes occur more frequently the flatter 

the intersection angle between the two planes involved. So, if the value for the allowed 

degree of overlap is set higher, the intersection lines of flatter intersecting alphashapes 

are suggested as candidates. The lower the value, the less intersection lines of flat 

intersecting alphashapes are suggested as candidates.  

    
overlaps: 0.05               overlaps: 0.15                             overlaps: 0.55 

❖ Extend: 

Intersection lines are generally as long as the common edge of two alphashapes. If one 

alphashape is larger than the other, this has no effect on the intersection line. If the 

Extend option is set, the actual length of the intersection line is ignored and set to the 

maximum length of the larger alphashape. 

Default: off 
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❖ Merge Intersection lines 

If intersection lines between two alphashapes are interrupted by a recess in the 

alphashape, they can be merged after accepting one of the intersection line segments 

if this option is set. 

Default: off 

      
 

 

 

2.3.3. Special editing functionalities 

2.3.3.1. Smart Preview Mode 

When the workspace is changed from selection mode to editing mode, the Smart 
Preview mode is set as the start function. You can switch between the editing modes 
using the hotkey or toolbar.   

If the mouse is over an intersection line (red), a preview of the face generation is 
displayed in Smart Preview mode when this intersection line (now blue) is accepted 
with a left mouse click. (Green) 

With a click of the right mouse button, accepted lines can be returned to the candidate 

status. If the mouse is then removed from the line, the face generation of the preview 

is also reset. 

By changing the settings that appear in the main toolbox when this mode is activated, 

the result of this preview can be changed/improved. 
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Lines (intersection lines and baselines) can also be edited in the Smart Preview, but for 

advanced line editing functions it is necessary to switch to line editing mode.  

• Extend: Intersection lines can be extended by moving the end points with the 

mouse. When intersection lines are extended, the associated baselines are 

automatically extended.  

• Show disregarded intersection lines: Shift + Ctrl can be used to display invalid 

intersection lines and invalid segments of valid intersection lines that were 

discarded during pre-processing because they did not meet one or more criteria 

for a valid intersection line candidate. With an LMC, these intersection lines can 

be transferred to candidate status and thus used for Smart Preview. 

• Move: Baselines can be moved in the plane by moving the centre point up or 

down with the mouse.  

• Split Line: Baselines can be split by holding down Ctrl and clicking on the line at 

the desired position. 

 

 

 

Parameter:  

❖ Set base plane automatically. 

If this option is not set, the base plane editing mode is available. In this mode, the 

height of the base plane can be set manually. If it is set, the height of the base plane 

is calculated automatically from the data. 

Default: on 

❖ AutoComplete 

With this option set, all intersection lines that are recognised by adjacent planes as 

belonging to a complex are transferred to the preview and can be accepted at the same 

time with a mouse click. With shift and mouse wheel candidates can be removed from 

the preview and added again. This function is recommended especially for simpler 

buildings, as it allows faster modelling. Default: off 
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❖ Show only invalid intersection lines (checkbox).  

If intersection lines not taken into account are to be displayed with Shift+Ctrl, this 

option can be used to filter the result. If NOT set, completely invalid intersection lines 

are displayed as well as the invalid segments of otherwise valid intersection lines. With 

this option, the invalid segments are suppressed and only the completely invalid 

intersection lines are displayed.   

❖ Apply to used planes only (checkbox).  

Another filter option for showing intersection lines that have not been considered. If 

this option is set, Shift and Ctrl will only find candidates with planes that are already 

used in the Smart Preview. 

2.3.3.2. Baseplane Editing Mode 

This mode is only active if the checkbox Set base plane automatically is deactivated in Smart 

Preview mode. The base plane is used to delimit the roof planes, the baselines are the result of 

the intersections between roof and base planes. If the automatically set base plane leads to 

undesired results for the base lines, it can be set manually in the base plane edit mode. 

With a left mouse click the base plane is set by the lowest point of the selected alpha shape.  

If Ctrl is additionally held down, a point of the pointcloud can be selected through which the base 

plane is set. 

2.3.3.3. Intersection line editing mode 

Lines can be edited in line editing mode as follows. 

• Lengthen/shorten: by means of LMK to the end points of a selected intersection line. 

• Move: LMK to the centre of a selected baseline. 

• Hold down Ctrl and LMK to the selected baseline. 

 

 

Tip: These three functions are also available in Smart Preview mode without selecting 

the line beforehand 

 

 

• Deactivate a selected intersection line (hold down the Shift key and click on the selected 

line again). 

• (Re-)activate selected intersection line (click on the selected line again with the shift key 

pressed) 

 

2.3.3.4. Alphashape-Editing Mode 

 

In some cases alphashapes are too large or too small. The following functions can be used to 
change the extension of an alphashape. 

Edit: 

• LMC selects an alphashape.  
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• Hold Shift + LMC on selected alphashape deactivates. 

• Hold Shift + LMC on selected (deactivated) alphashape reactivates. 

• Hold Ctrl + LMC on alphashape segment adds new vertex. 

• Hold Ctrl + LMC on alphashape vertex deletes vertex. 

• LMC on alphashape vertex moves vertices.  

 

Sometimes alphashapes are not found even for smaller planes (depending on the creation 
parameters). In these cases, they must be created manually. There are several possibilities for 
this in the alphashape mode: 

 

Add: 

• Hold Ctrl and select one point after another with LMC to define a plane. With a LMC on the 

first point the polygon will be closed and the plane created. At least three points are 

necessary. 

• Hold Shift + LMC selects a number of points. This selection can be extended or reduced 

dynamically with a mouse wheel scroll. With an LMC the selection is accepted and the 

alphashape is created. 

• Hold Shift + Ctrl selects a number of points in a forced normal plane (horizontal). This 

selection can be dynamically expanded or reduced with a mouse wheel scroll. With an LMC 

the selection is accepted and the alphashape is created.  

• Hold Shift + Klick of the mouse wheel! several points are 

selected but not completed. More clusters of points can be 

added to the selection with the same key combination held 

down. Only an LMC finishes the selection and creates the 

plane. 

 

 

For slightly bent roofs and other situations it is advantageous to split or merge an alphashape. 

When splitting an alphashape, the originally assigned points are reordered and assigned to the 

two new alphashapes. An intersection line is created between the two new alphashapes, 

making it easier to model slight bends. When an alphashape is selected, the following functions 

are available: 

• Horizontal division (draw a horizontal dividing line with two clicks) 

allows you to create a horizontal dividing line through the selected alphashape with 

two mouse clicks. 

• Vertical division draw a vertical dividing line with two clicks) 

allows you to create a vertical dividing line through the selected alphashape with two 

mouse clicks. 

• User defined division (draw a user defined dividing line) 

allows you to create a user-defined dividing line through the selected alphashape with 

two mouse clicks. 

• Merge allows you to merge the selected alphashape with another alphashape. 
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❖ Parameter:  

❖ Application radius (Slider) 

Within this radius, pointcloud points are searched for during the alpha shape creation. 

The larger the radius around the mouse position, the more points are added to the 

selection. 

❖ Use assigned points (Checkbox)  

If this option is set, all alphashape actions can only be performed on the points that 

are already used in alphashapes.  

 

2.3.3.5. Outline Editing Mode 

To make an outline visible and thus editable, the alpha shape concerned must first be 

selected in outline mode. Only then will the created footprint be displayed.  

 

Edit 

In the 2D window as well as in the 3D window, vertices can then be added to the outline, 

moved and in most cases also deleted. Vertices at the intersection line cannot be moved 

or deleted. 

 

• Press Esc to end the active selection. 

• LMC on an alphashape its outline is also selected. 

• De- and (re-)activating a selected alphashape in alphashape mode also de- or (re-

)activates its outline. 

• Hold Ctrl + LMC on outline vertex deletes this vertex. 

• LMC on vertex allows moving. 

 

 

Note: As there are no sections of roof planes in flat roof situations, the face-generating 

outlines must be created manually here. There are several ways to do this. 

 

Add: 

• Select alphashape, which specifies the plane of the future roof. Draw the desired 

outline in the 2D window. An outline is automatically created in perpendicular mode 

after the second click. To suppress this, you must also press Shift.  The last click must 

be on the first point to complete the polygon. 

 

Tip: The last corner of a roof does not have to be drawn with the perpendicular mode 
active, if the first three points have been digitised, the last click can be made on the 

first point, the polygon is automatically closed, and the last roof corner is automatically 

created. 
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Tip:  An outline can also be created in the 3D window, but it can be drawn with more 

control in the 2D window. 

 

 

Tip: If the main roof is not visible due to a parapet or other roof structures, the creation 
mode can be selected (In the main plane, In the drawing plane). If in the main plane 

is selected and the height is set to the height of the parapet using the Set drawing 

plane button, the outline can be drawn on the parapet in the 2d window, but the 

outline is created on the plane of the alpha shape. 

 

If building footprints have been included in the calculation for a project (chapter...), 

these can be used for an easier flat roof creation. The prerequisite is a suitable quality 

of the footprints. Select the alphashape concerned to define the plane (height and 

inclination) of the future roof. Activate the button Use footprint and select the 

footprint that is to be lifted into the plane of the selected alphashape. The new outline 

is created 2D identical to the building footprint in the plane of the alphashape. The 

outline can still be edited in these cases as well.  

 

• Parapets:  

A flat roof can also be created immediately with a parapet. To do this, select the 

creation mode (main plane with parapet), select a point at the top edge of 

the parapet for the height of the drawing plane, set the width of the parapet (note that 

this cannot be changed afterwards) and draw the outline in the 2D window on the 

outer edge of the parapet. After closing the outline, the main roof is at the height of 

the selected alpha shape, the parapet is at the height of the set drawing plane. 

Parameters: 

 

• Creation Mode (Dropdown) 

❖ In the drawing plane: The outline is created in the set drawing plane, at 0 the 

drawing plane corresponds to the main plane. 

❖ In the main plane: The outline is created in the main plane (of the selected 

alphashape). 

❖ In the main plane with parapet: The outline is created in the main plane, the 

parapet in the set height of the drawing plane. 

• Height drawing plane (slider) relative height, 0 is the main plane. 

• Parapet thickness (slider) must be set before creating a parapet. After that, the width 

can no longer be changed. 

• LoD of the parapet (Dropdown)  

❖ 1  

❖ 2 Is treated as part of the main roof in CityGRID® xml. 

❖ 3 is treated as a detail element complex in CityGRID® xml. 

• Set drawing plane (button) If this button is activated, a point of the pointcloud can be 

selected at the desired height. The height of the drawing plane is set to the height of 

the point. 
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• Select footprint (button). If this button is activated, a building floor plan can be 

selected, which is subsequently raised to the height of the main plane and accepted as 

an outline. 

2.4. The 3D Window 

In the 3D window the calculated pointclouds and the derived data (depending on the visibility settings) 
are displayed. The alphashapes, the intersection and base lines, as well as the surfaces can be displayed 
here. All lines and polygons can be edited here in the corresponding editing modes.  

Moving in the 3D window:  

❖ Rotate with right mouse button. 

❖ Pan by pressing the mouse wheel. 

❖  Zoom by scrolling the mouse wheel. 

2.5. The 2D Window 

In the 2D window the calculated aerial images are displayed. In the image selection it is possible to 
switch to another aerial image. The active building is represented in the selected aerial image with 
intersection lines and a face representation. In the different editing modes, it is also possible to edit in 
the 2D window. (Outline, alphashape and lines). 

Move in 2D Window: 

❖ Zoom by scrolling the mouse wheel.  

❖ Pan by pressing the mouse wheel. 

2.6. The Log Window 

All Shaper processes are logged in the log window. If there are any crashes or warnings, they are displayed here. 
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3. Working with CityGRID® Shaper 

3.1. Creating a Shaper project 

A project directory must be entered under the menu item File->New. Subsequently, the wizard 

Create Shaper Data opens automatically and guides you through the creation of the project. 

Here the parameters for an FME workspace are set, which was saved in the programme directory 

during the installation of the CityGRID® Shaper. 

 

3.1.1. Pointcloud settings (required)  

 

❖ Pointcloud: Selecting one or more .las or .laz files (required) 

❖ Boundary: Select a shape file that restricts the pointcloud(s) to a working area. For example, 

building footprints (processed with buffer) or an area boundary. (Optional) 

❖ Orthophoto: Select one or more ortho images to colour the pointclouds (Optional) 
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❖ Building Class: For classified pointclouds, the class number on which the buildings are located. 

For unclassified pointclouds, it is recommended to create a Building Class and assign it a 

corresponding number, which is specified here. Default is 6. 

❖ Overwrite point colour: Controls whether an already coloured pointcloud is to be overwritten 

with the values of the orthoimage.  

 

Help: Provides more detailed information about the parameters on this wizard page. 

Next: Switches to the aerial image parameter settings. 

3.1.2. Aerial Image Settings (optional)  

 

❖ Aerial images: This navigates to the aerial image orientation file(s) in the form of a CityGRID® 

xml file. 

❖ Image scaling (10-100): Scales the image sizes of the aerial images used. Helpful for very high-

resolution aerial images, improves performance at the expense of image quality. 100 full image 

size, 10 are 10 percent of the initial image size. Default 100 (no reduction). 

 

Help: Provides more detailed information about the parameters on this wizard page. 

Next: Switches to the settings of the environment data. 
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3.1.3. Environment Data Settings (optional)   

 

❖ Existing buildings: Existing CityGRID® city model data can be added as reference data to a 

shaper project. This facilitates city model updates. Requires CityGRID® XML. 

❖ Terrain. Terrain data can be used to get a better impression of an area to be modelled. If a 

terrain is available, the building facades of the models are intersected with it and written into 

the file as Terrain Intersection Line (TIC) or CityGRID® Terrain during export. Requires CityGRID® 

XML. 

❖ Building footprints: Serve for easier orientation in the shaper project, or as modelling aids for 

flat roof buildings. Are written into the file as User defined Layer during export. Requires ESRI 

shp. 

 

Help: Provides more detailed information about the parameters on this wizard page. 

Next: switches to attribute definition. 
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3.1.4. Settings attribute definition (optional)   

 

 

 

In the attribute definition, attributes can be defined for buildings that are valid for the entire 

project. They can be edited or deleted subsequently. You can choose between 5 types for the 

attribute definition. 

❖ String. Allows a user-defined text field. 

❖ Integer. Restricts the entry of a value to integer values. A min and a max value can be entered. 

❖ Double. Allows decimal numbers. A Min and a Max value can be entered, as well as a precision. 

❖ Dropdown. Allows you to choose between predefined values, 

❖ Date. Allows you to enter a date in a predefined format. There are four predefined formats to 

choose from, but a user-defined format is also possible. 

 

Tip: Instead of creating a new attribute definition manually, the definition from an 

existing project can also be used by navigating to an existing project file with the ... 

button. 

The Optional column indicates whether an attribute is required or not. 

The Details column shows a summary of the definition given.  

The X button allows you to delete a line. 

Help: Provides more detailed information about the parameters on this wizard page. 

Next: Switches to the summary. 
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3.1.5. Summary 

 

 

❖ Shows an overview of the set parameters. 

 

Finish: Starts the calculation of the shaper project. Depending on the amount of data, this may 

take several hours. 
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4. Integrating and updating external data 

For certain areas of application, the integration of various external (auxiliary) data is useful.  

❖ Building footprints 

Facilitate orientation in the pointcloud, in outline mode footprints enable the quick creation 

of (some) flat roofs. The prerequisite is a certain minimum accuracy and topicality of the 

footprints. Flat roofs that are created using a building footprint should not have a roof 

overhang. In this case, the roof must be subsequently processed and extended. 

❖ Terrain 

Creates an intersection with the created façade surfaces and gives a realistic impression of 

modelling. 

❖ Existing building models 

Facilitate the updating of an existing city model, as new building models can be snapped to the 

existing buildings and thus avoided. If errors are found in the existing city model, the affected 

building can be identified with an original file and edited there. 

The data can either be included right at the beginning when calculating the shaper project 

(Chapter 3.1.3) or subsequently with Menu > Edit > Optional data (Chapter 2.1.2.1) 

 2.1.2.1). 
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5. Error Handling  

The CityGRID®  Software is developed, tested and maintained by UVM Systems with the aim of being 
error-free. Nevertheless, we cannot exclude the possibility of errors occurring during processing. 

The database concept and version management guarantee that data cannot be lost. If an error in the 
software actually corrupts the data of the edited version, there is still the last stable version, which has 
not changed. In important cases, corrupt versions can usually still be repaired if the error has been 
found. 

The following errors can occur: 

If you want to send a bug report, please include the following information/data: 

1. description of the actions that led to the error. 

2. send the data in the menu Feedback > Send Feedback to the CityGRID® Support Team 

 

For errors in the shaper: 

If the error is reproducible in the shaper, we also ask for a detailed log: 

1. perform all actions before the error occurs. 

2. activate in the menu Feedback > Extended Logging (slows down the software considerably). 

3. Execute the action that produces the error. 4. 

4. send the data in the menu Feedback > Send Feedback to the CityGRID® Support Team 

5. deactivate detailed logging again. 

Please send bug reports to support@uvmsystems.com  

mailto:support@uvmsystems.com
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6. Contact 

 

 

 

 

 

www.citygrid.at 

www.uvmsystems.com 

 

http://www.citygrid.at/
http://www.uvmsystems.com/

